Introduction

Hearing Instrument Testing (HIT) measures the hearing instrument response in a 2 cc coupler in the test chamber. The coupler response is then compared to the manufacturer specification to ensure quality performance or to detect possible malfunctions of the hearing instrument.

This system follows the ANSI S3.22-2003 and IEC 60118-7 (2005) standards for hearing aid measurement methods.

The Avant Polar HIT supports the following measurements:

- OSPL-90
- Full on Gain
- Reference Test Gain
- Frequency Response
- Equivalent Input Noise
- Harmonic Distortion
- Input/Output (AGC)
- Battery Current
- Attack/Release
- Induction Coil
- Directionality

The AVANT Polar HIT represents a new era of precision Hearing Instrument Testing for your office. Compact yet rugged, this PC-Based system is USB powered and performs all required ANSI and IEC tests. A unique feature of the Polar HIT is a rotating test pad, which allows you to generate polar plots to verify the performance of directional microphones upon delivery and following repairs. This manual will explain the available tests and provide step-by-step instructions for all supported tests.

This manual assumes that the system hardware, software and drivers are installed and working properly. Please refer to the MedRx Avant Polar HIT Installation Manual for assistance.

The scope of this manual is to get you “up and running” with the AVANT Polar HIT System. Please consult the interactive Help System within the software for more detailed information of features and functionality. To access this tool, press the F1 key at any time, or click the Help icon or text menu with your mouse.
The AVANT HIT Software

General Overview

The AVANT HIT software will either run as a part of the AVANT Software Suite (figure 1), or as a stand-alone module (figure 2). The AVANT Software Suite can run stand-alone or from NOAH System or the TIMS NOAH-Compatible Office System.

Launching the HIT Software

Stand Alone

1. Double click the AVANT HIT shortcut on your Windows Desktop

NOAH and TIMS

1. Launch NOAH
2. Click the Module Selection icon
3. Click the Measurement Tab
4. Double click the AVANT icon
Software Options

Basic Options

The software allows you to set several default options as described below. To access the Options screen, click File, then Options from the Avant HIT main window.

Options may also be accessed using the Options menu once inside the Hi Test software.

The View tab allows you to set the default appearance of the HIT test environment. Values can be changed by using the check boxes and pull-down menus shown above.

The HIT Tab allows you to select the relevant Standard for your measurements (ANSI S3.22-2003 or IEC 60118-7 2005) as well as the general parameters for your HIT measurements.

Note: HIT functionality is available in several MedRx products. These screens may vary slightly depending on the product. Consult the interactive help system in the product you are using the HIT.
**Advanced Options**

The Advanced Options screen allows you to configure your system to meet your individual clinical needs. It also provides MedRx Technical Support with tools for helping you technical issues. Access this screen from the File Menu on the Avant Main Screen as shown to the right.

The key features of each tab are described below. For more in-depth information, consult the interactive Help system within the software.

- **General Tab**: Configures the overall Avant HIT environment and behavior with respect to other Windows programs, specifically NOAH.

- **Audio Tab**: Use to select the proper audio device for your Avant HIT. If necessary, this tab also provides access to the Windows Audio controls.

- **Video Otoscope Tab**: Allows you to select the appropriate device driver for a Video Otoscope.
Preparing for ANSI/IEC Hearing Instrument Testing

Attaching Hearing Instruments to the Coupler

ITE (In The Ear), ITC (In The Canal) and MIC (Mini Canal) Hearing Instruments

1. Seal acoustic vents.
2. Wrap the canal portion of the instrument with a hermetic sealing material such as Bostik Blu-Tack (see Figure 1).
3. Align the sound bore with the opening of the ITE coupler adapter. Press the sealing material firmly into the ITE adapter (see figure 2).
4. Ensure that the black o-ring is installed in the 2cc coupler and snap the ITE adapter in place (see Figure 3).

Figure 1  Figure 2  Figure 3
Attaching Hearing Instruments to the Coupler (cont.)

BTE (Behind The Ear) Hearing Instruments

1. Remove earmold from hearing instrument.
2. Attach ear hook to 20mm long Tygon tube on BTE Coupler Adapter (see Figure 4).
3. Snap the BTE Coupler Adapter onto the 2cc Coupler (see Figure 5).

![Figure 4](image1.png)
![Figure 5](image2.png)

Hearing Instruments with Button Receivers

1. Remove earmold from hearing instrument.
2. Attach the button receiver to the Coupler Adapter and seal with putty (see Figure 6).
3. Snap the Button Receiver Coupler Adapter onto the 2cc Coupler (see Figure 7).

![Figure 6](image3.png)
![Figure 7](image4.png)
**Positioning Hearing Instruments to the Test Chamber**

The AVANT Polar HIT chamber utilizes two speakers positioned 90° apart. When placing hearing instruments in the chamber, it is critical to place the hearing instrument microphone adjacent to the reference microphone. The center of the sound inlet of the hearing instrument microphone should be between 2mm and 8mm from the center of the reference microphone. Proper positioning for ITE, BTE and Body Worn hearing instruments are shown below.

![ITE Hearing Instrument](image1)

![BTE Hearing Instrument](image2)

![Body Worn Hearing Instrument](image3)

Once the instrument is properly placed in the test chamber, turn the power on and close the lid of the chamber. The latch will engage which an audible “click” when the lid is closed properly.

Notes:

1. ITE instruments are aligned as if they are being worn and the patient’s nose is facing the **Secondary Speaker**.
2. BTE instruments are aligned as if they are being worn and the patient’s nose is facing the **Primary Speaker**.
3. Battery pills are used for ITE and BTE Instruments, but not for Body Worn Instruments.
Making HIT Measurements

General overview

The AVANT HIT software is designed to make the process of making HIT measurements simple. The easiest way to complete them is to use the Auto Test feature.

Setting Auto Test Preferences

1. From the AVANT HIT Main screen, click HI Test.
2. Click the Setup button below the list of tests.
3. In the Test Setup Window, add or remove the tests you want to include in your Auto Test battery.
4. Select the appropriate amplifier and battery type.
5. Select the test frequencies you wish to use.
6. Select your default stimulus.
   • For ANSI and IEC tests, select Tone.
   • To evaluate the performance of noise reduction circuits, select Speech Noise.
   • Select other stimuli as dictated by your clinic policies or jurisdiction’s regulations.
7. Click Save to store your preferred settings
8. Click OK to close this window.

After setting your default preferences, simply place the hearing instrument into the test chamber as described in the Avant Polar HIT Installation Manual and click the Auto button then click Start.
Sample HIT Measurements

The screenshots below illustrate the Avant Polar HIT representations of the ANSI S3.22-2003 Hearing Instrument Test Battery. The system also supports the IEC 60118-7 2005.

OSPL90

Full-On Gain

Reference Test Gain

Frequency Response

Equivalent Input Noise

Total Harmonic Distortion

Battery Current

Input/Output

Attack/Release

Induction Coil
Testing Directional Hearing Instruments (Polar Plots)

The Avant Polar HIT is unique in its ability to produce manufacturer-quality Polar Plots in your office. This is accomplished using the Avant Polar HIT software and the unique Rotating Test Pad.

**Attaching Hearing Instruments to the Coupler**

**ITE (In The Ear), ITC (In The Canal) and MIC (Mini Canal) Hearing Instruments**

1. Seal acoustic vents.
2. Wrap the canal portion of the instrument with a hermetic sealing material such as Bostik Blu-Tack (see Figure 1).
3. Align the sound bore with the opening of the ITE coupler adapter. Press the sealing material firmly into the ITE adapter (see figure 2).
4. Ensure that the black o-ring is installed in the 2cc coupler and snap the ITE adapter in place (see Figure 3).

**BTE (Behind The Ear) Hearing Instruments**

1. Remove earmold from hearing instrument.
2. Attach ear hook to the right angle tube on BTE Coupler Adapter (see Figure 4).
3. Snap the BTE Coupler Adapter onto the 2cc Coupler (see Figure 5).
Positioning Hearing Instruments to the Test Chamber

The AVANT Polar HIT chamber utilizes two speakers positioned 90° apart. When placing hearing instruments in the chamber, it is critical to align them so the primary hearing instrument microphone is perpendicular to the grille of the primary speaker. The Primary Speaker is on your right. Proper positioning for ITE, and BTE hearing instruments are shown below.

Once the instrument is properly placed in the test chamber, turn the power on and close the lid of the chamber. The latch will engage which an audible “click” when the lid is closed properly.

Notes:

4. ITE instruments are aligned as if they are being worn and the patient’s nose is facing the Secondary Speaker.

5. BTE instruments are aligned as if they are being worn and the patient’s nose is facing the Primary Speaker.

6. Battery pills are used for ITE and BTE Instruments, but fresh Zinc Air batteries may also be used.

Performing Polar Plot Testing

1. Select the Directionality Test from the list on the right of the screen.
   - NOTE: Be sure to set the hearing instrument into Directional Mode

2. Click
3. Click

NOTE: During testing, the software will prompt you to manually rotate the test pad either clockwise or counter-clockwise. Please refer to the figure below for reference.

7. Follow the screen prompts (circled in red below) to complete the test.

NOTE: When the rotational cycle is complete, the button replaces the button.
A completed Polar Plot is shown below.

Interpretation:

The polar plot shows the measured sensitivity of the microphone for input signal at different angles. Here we see that the microphones of this hearing instrument have maximum sensitivity when the test signal (1000 Hz pure tone) is in front of the hearing instrument (+/- 75°).

The minimum sensitivity, or null of the system occurs between 105° and 120° to either side of the center of the hearing instrument.

While there is still measurable sensitivity directly behind the hearing aid (180°), the system is significantly less sensitive to sounds in this position.

This type of microphone configuration will provide a patient with noticeable improvement in speech discrimination in noise.

Clinical Use of Polar Plots

Integrating new technology into your daily routine takes a bit of time and effort, but being certain that your premium product line is in peak condition for every patient is well worth it. Testing each hearing instrument upon receipt in the Avant Polar HIT chamber provides you with the confidence to know that one of the key features in each patient’s hearing instrument fitting is functioning according to specification before the appointment is made. Identifying these problems and rescheduling is far better than sending a patient into the world with expectations that cannot be met.

As of 2007, there have been many peer-reviewed scientific papers demonstrating the benefits of directional microphones for people with sensorineural hearing loss. Further, the MarkeTrak surveys continue to show that discriminating speech in noise is one of the greatest challenges and most desired outcomes for people purchasing hearing instruments.

The majority of hearing instrument manufacturers offer sophisticated directional microphone systems, however other data reveals that manufacturing and shipping mishaps result in a large percentage of instruments arriving at your office with malfunctioning directional microphones.

Additionally, the Avant Polar HIT allows you to quickly and precisely diagnose when directional microphones fair or become misaligned after the sale. This expedites the repair process and ensures
your practice maintains the highest level of patient satisfaction and repeat business. Finally, the Avant Polar HIT is also a comprehensive ANSI and IEC test chamber which allows you to also diagnose distortion, weak amplifiers and malfunctioning telecoils.

**Printing**

The AVANT POLAR HIT software allows you to print tests individually or as a complete multi-test report.

**Printing Individual Tests**
1. Click File
2. Click Print

**Printing Multi-Test Reports**
1. Click File
2. Click Print Report
Limited Warranty

MedRx, Inc warrants the AVANT POLAR HIT TM System to be free from defects in material and workmanship for one year from the time of purchase. If this system fails to perform as specified during this period, the purchaser is responsible for calling MedRx at (888) 392-1234. The company's representative will advise the owner to either return specific components or the entire system to:

MedRx, Inc.
1200 Starkey Road #105
Largo, FL 33771

MedRx will repair or replace any defective parts, fully test the system and/or components and ship the system promptly back to the owner. There is no cost for this warranty service, provided the system is one year old or less and has not been misused, abused or damaged. Such damage includes, but is not limited to, dropping, exposure to excessive heat greater than 100°F and water/liquid damage.

Repair or replacement of the system as provided under this warranty is the sole and exclusive remedy of the purchaser. MedRx shall not be liable for any consequential or incidental damages, or for breach of any express or implied warranty. Except to the extent of applicable law, any implied warranty, merchantability or fitness of this product is limited to the duration of this warranty.

MedRx will, at its discretion, service and repair out of warranty components at the purchaser's request, charging for parts and labor as necessary.

The limited warranty is deemed void if software or hardware is installed on the AVANT POLAR HIT TM which is not pre-approved by MedRx, Inc. Approved software includes NOAH™ and HIMSA approved hearing aid manufacturer programming modules for fitting hearing aids.

MedRx, Inc is not responsible for problems resulting from installation of unapproved software or hardware. In the event of unapproved software or hardware installed on the system causing a conflict with the AVANT POLAR HIT TM functions, MedRx will service the problem for a fee to be determined at the time of service.

Consult your MedRx Technical support member for other alternatives for back up.